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Using iTools Tutorial 

 
 

PART I 

1.) Launch an iTool™ 
 
Begin at the IDL command line by restoring the sample data used in the tutorial: 
 

RESTORE, ‘itools_tutorialone_data.sav’  
 
Depending on where the file is located on your system, you may need to use a fully qualified path 
in the above command. 
 
Next, type the command “IPLOT”, and pass in the variable “theory”.  You can also specify titles 
for the x and y axes.  This is to demonstrate that the iTools commands accept many keywords 
that are similar to Direct Graphics keywords with which you may already be familiar: 
 

IPLOT, theory, XTITLE="Time Index", YTITLE="Amplitude" 
 

When you hit return, an iPlot window with the “theory” variable plotted will appear.  The first time 
you initialize the iTools in an IDL session, IDL must compile the iTools library.  This can take a 
couple of seconds.  Subsequent calls to the iTools routines will be faster. 
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2.) Interface  
The iTools user interface is designed to be very intuitive with common standards in mind. Notice:  
 
• The menu system. 
• The toolbar, with familiar icons for things like save, print, copy, and paste. 
• The display area, which can contain multiple visualizations. 
• The status area at the bottom, which contains status messages on the left and reports the 

mouse cursor position on the right. 
 

3.) Selection   
There is a concept of selection in the iTools.  By default, the plot is selected, and there is a 
selection visual that indicates this.  If you click off the plot it becomes deselected.  You can click 
on individual axes and move them around (e.g., drag the y axis along the x axis).   
 

4.) Select Mode 
If you look at the toolbar, you can see the arrow icon  is depressed.  This default mode is 
called select mode (or arrow mode).  Move your mouse around the plot and see that the mouse 
cursor changes shape depending on what part of the selection visual it is hovering over.   
 
• Hover over the middle of the plot and you are able to translate, or move, the plot.   
• Hover over the green square in one of the corners and you are able to freely resize, or scale, 

the plot.   
• Hover over the green square in the center of one of the edges and you are able to resize the 

plot constrained in one dimension.  
 

5.) Zoom Mode 
Turn your attention to the toolbar again, and move a couple of icons over to the zoom icon.  
In Zoom mode, you can drag with your mouse in the window and zoom in and out on the plot. 
 

6.) Text Annotation Mode 
Moving over a couple more icons to the right in the toolbar, you find the Text Annotation icon.   
If you enable this mode, then click in the window, you can type text directly onto the screen.  Type 
the words, “Theoretical Data”.   You now have a text object that you can select and move around. 
 
Once you have typed a text object, if you want to modify an existing text object, you can go back 
into the Text Annotation mode and click on the text object.  This will insert a cursor where you 
clicked, so that you can continue typing.  Change the text string to read, “Theoretical vs. 
Observed Data”.  
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7.) Properties 
 
Every object in an iTool window has a set of characteristics called properties associated with it.  
Properties include things like color and line thickness.  You can view and modify the properties of 
any object by either double clicking on the object or right clicking.   
 
Right click on the text object.  This will bring up a context menu.  The context menu includes 
options like cut, copy, paste, grouping, and ordering.  Chose the last option in the list, which is 
Properties….  This will bring up a property sheet for the text object.  It lists all of the properties for 
the object and allows you to change their values.  Change the color property of the text from 
black to blue.   
 
Now click on the plot line, and notice that the property sheet updates to reflect the plot line 
properties.  Rename the plot line to “Theory”, change the line color to red, and make the plot line 
thicker (a value of 3 is a good choice).  Leave the property sheet up as you continue the tutorial. 
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Note:  The property sheet is actually a widget, also introduced in IDL 6.0, that IDL programmers 
can use in their own code to interactively view and modify the properties of IDL objects.   

8.) Undo/Redo 
 
Any change you make such as a property change or resize/translation is undoable and redoable.  
The iTools have an unlimited undo/redo buffer, also known as the “command buffer.”  The 
command buffer is limited only by the memory on your system, but you can set a preference for 
the size of the command buffer that you want to use.   
 
There is an Undo icon in the toolbar . Click once on this, and notice that the change you made 
to the plot line thickness will be undone. Click again, and see that the change you made to the 
line color will be undone.  Click twice on the Redo icon  so that both changes are restored. 

9.) Overplotting 
 
This step demonstrates how to overplot new data in the iTools.  There are several ways to import 
data into a tool.  For this example, use the File/Import option to import an IDL variable from the 
IDL command line. 
 
This will bring up the Import Wizard to step you through importing data and creating 
visualizations.   
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In the first screen, choose to import data “From an IDL Variable” and hit Next.   
 
In the next screen, you will see a list of variables.  Choose the variable called “OBSERVED” and 
then hit Next.   
 
The following screen prompts you to select the type of visualization you want to create.   
 

 
 
The “OBSERVED” variable is just a simple vector, so you can hit Finish, and the iTool will go 
ahead and create a plot line that will be overplotted in the existing plot. 
 
Note that the property sheet now displays the properties of the new plot line.  Change the name of the new 
plot line to “Observed”.  Also, give the plot line an asterisk plotting symbol. 
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10.) Plot Legend 
 
To insert a plot legend, you will need to multi-select the plot lines (the legend will include any 
selected plot lines).  To do this, you can use a shift-click or, you can drag a rubber band box 
around the entire plot.  Then, go to the Insert menu for the tool and choose to insert a Legend.  
This will insert a plot legend that contains both the “Theory” and “Observed” lines, showing their 
attributes like color, thickness, line style and plotting symbol.   
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11.) Operations 
 
The iTools contain built-in analysis capabilities, which apply to the currently selected items.  The 
Operations menu contains options for viewing data statistics, viewing a histogram (or density plot) 
of a dataset, applying convolutions, resampling, etc.  With the “Observed” plot line selected, 
choose the Filter/Convolution operation.  In the ensuing dialog, choose “Boxcar” from the droplist 
of provided convolutions kernels and hit OK.  You should notice that the black plot line has been 
smoothed.  Operations are undoable and redoable too.  Undo and then redo the convolution 
operation you just applied.   
 

PART II 

12.) Visualization Browser 
 
This step demonstrates an alternative way to select objects, using the Visualization Browser.  At 
the top left corner of the property sheet window, there is a small arrow button.  Click on it to 
expand the window to reveal the Visualization Browser.  You can also expose the Visualization 
Browser through the Window menu of the tool.   
 
The Visualization Browser displays a hierarchical view of all of the contents of the tool, starting 
with the Window itself.  The window can contain multiple Views, depending on the layout of the 
tool.  Each View contains two layers:  a visualization layer and an on-glass annotation layer.  In 
this case, your annotation layer contains your title and legend.  The visualization layer contains 
the dataspace (and there can be multiple dataspaces in a single view).  The dataspace contains 
the visualization items (plot lines, in this case), and axes.  Click on the visualization items and drill 
down to see the properties of the data parameters.   
 

  
 
The Visualization Browser is handy not only so you can see the hierarchy of objects in your tool, 
but also in cases where it may be difficult to select items in the display.  For instance, you may 
have items that are overlapped.  Or, you may want to temporarily hide an object.  If you do this, 
the only way to select the item in order to show it again is through the Visualization Browser. 
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13.) Layout Control 
 
To control the layout of a tool window, go up to the Window menu and choose Layout….  By 
default, an iTool has a single view in a 1x1 grid.  There are several other layout options to choose 
from, including Inset, Trio, and Freeform.  Choose a gridded layout and specify 2 columns and 2 
rows.   

 
 
You now have three new empty views with which to work.  To select a view, click on it.  The view 
will be highlighted with a red rectangle. 
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14.) Surface Visualization (and Gridding Wizard) 
 
Even though you started with an iPlot, you can easily display different kinds of data in your 
window.  Create a surface visualization in the top right view.  First select the view.  There are 
several ways to import data into this view to create a new visualization.  For this step, go to the 
IDL command line and type a command to pass some surface data in:   
 

ISURFACE, clouds, xx, yy, /OVERPLOT 
 
The OVERPLOT keyword will insert this surface into the selected view in the existing iPlot 
window.  The variables you are passing in are actually three vectors of irregularly sampled Z, X, 
and Y data points.  They need to be gridded to form a 2D array that can be displayed as a 
surface visualization.  The iTool is smart enough to recognize that the data passed to the 
ISURFACE command are not surface data.  As a result, the tool will present a dialog asking you 
to choose whether to grid the data (the default).  Hit OK.  
 
This will bring up the gridding wizard to step you through the process of gridding the data.  The 
first screen displays the irregularly sampled point collection.  The second screen allows you to 
specify the grid size and locations (keep the defaults and hit Next).  The third screen allows you 
to select from various gridding algorithms and options, view statistics, define a search ellipse, and 
view a preview of the results.  Choose the Inverse Distance algorithm.  In the Options tab, apply a 
smoothing factor of 1.0 (hit return in the text field for this to take effect).  Then, hit the Preview 
button to see what the gridding result will look like.  You can now hit Finish.   
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A yellow surface will appear in the selected view.  Switch to the Rotate mode  in the toolbar 
and rotate the surface in 3D.    
 

 

15.) iTools Adaptation  
 
When you inserted the new surface visualization into the plot tool, something happened:  new 
surface-oriented functionality was enabled, creating a hybrid tool.  The iTools adapt to handle the 
data you throw at them—thus the name Intelligent Tools.  Here are a couple of things that 
happened:  
 
• A new contour icon  showed up in the toolbar that allows you to interactively drag contours 

on a surface.   
• A Contour operation and an Image operation were added to the bottom of the Operations 

menu. 
 

16.) “Show 3” Visualization 
 
With the new surface selected, apply the new Contour operation in the Operations menu.  This 
will insert a contour of the surface data in the visualization at Z=0.  In the property sheet for the 
contour, change the “Planar Z value” property to 0.7 to position the contour plane right above the 
surface.  Next, with the contour selected, go back to the Operations menu and choose the Image 
operation.  This will insert an image display of the data at Z=0.  If you are familiar with IDL Direct 
Graphics plotting commands, you will recognize this as a “Show3” visualization.  
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17.) Side Panels 
 
When the image was created in the last step, you probably noticed a more obvious adaptation.  
This was the appearance of the right hand side panel.  The panel contains short-cut controls for 
special image functionality that users may want to access frequently.  Both the image and volume 
tools have side panels of controls.  They are enabled when an image or volume is selected, 
respectively. 

18.) Image Visualization  
 
Generally, when you import image data into an iTool, you will get a traditional, flat image for 
image processing, manipulation and ROI definition.  You happen to have an image displayed in 
3D space in this case.  For the purposes of this tutorial, you can go ahead and apply operations 
and manipulations to the image in 3D.    
 
In the side panel there is a vertical histogram for the image.  The histogram has green, black and 
red bars with handles. Drag them up and down in order to control the image window and level, or 
contrast and brightness.   
 
There are also icons for drawing regions of interest on the image.  Select the rectangle region of 
interest icon  and drag out a small rectangle directly on the 3D image.  With the ROI selected, 
go to the Operations menu and choose Statistics.  This will bring up a window with the ROI 
statistics.  Dismiss the window before continuing.   
 
Note:  You can hide the side panel by clicking on the arrow button at the top left corner of the 
panel. 
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19.) Copy and Paste 
 
Next, create a contour visualization in an empty view using the local clipboard functionality in the 
iTool.  To do this, select the contour in the “Show 3” visualization.  Then, right click and choose 
Copy from the context menu.  Next, select the bottom left view.  Right click in it and choose 
Paste.  This will create a 2D contour display.   
 

 

20.) Canvas Zoom 
 
To focus in on a single area, you can use the Canvas Zoom feature, which is accessed via the 
Window Menu.  First, select a value of 50% from the menu list.  This will zoom out on the entire 
canvas so that it takes up just a quarter of the window.  Next, select a value of 200%.  This will 
zoom in so that a single quadrant of the 2x2 grid is shown at a time.  Scroll down to the view with 
the new contour visualization in it and continue with the next steps to adjust the properties of the 
contour plot.   

21.) Contour Visualization 
 
In the property sheet for the contour, change the “Use palette color” property to True. (Make sure 
you are selecting the contour in view 3)  This will assign each contour level a color according to a 
selected color table (indices are mapped to the color table proportionately to the level values, with 
the minimum of the data at the 0 index and the maximum of the data at the 255 color index).  
Now, edit the “Levels color table” property.  In the ensuing dialog, hit the “Load Pre-defined” 
button to choose one of the pre-defined color tables.  Hit OK to apply the change.  You should 
now see how the contour levels now have colors pulled out of the color table you chose. 
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To give those colors some meaning, insert a legend.  With the contour visualization selected, go 
to the Insert menu of the tool and choose to insert a Legend.  This is similar to the plot legend you 
inserted in Part I of the tutorial, but when applied to a contour, the legend shows the values for 
the individual contour levels.  
 
Next, edit the properties of individual contour levels.  To do this, go into the “Contour level 
properties” property of the contour plot.  This will bring up a new property sheet that has multiple 
columns.   

 
 
Each column displays the properties of an individual contour level in the contour visualization.  
The first column is titled “All levels”.  Use this first column to change the “Line thickness” property 
of all of the contour levels.  Next, select the Level 4 column and change the “Line style” property 
of this single contour level.  Hit OK to dismiss this modal dialog and see the results. 
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22.) Volume Visualization 
 
Create a volume visualization in the remaining empty view.  To do this, scroll over to the view and 
select it.  Then, go up to the Insert menu and choose Visualization….   This will bring up a dialog 
that will allow you to choose existing data from the data manager or import new data, then assign 
parameters for a new visualization.   
 
On the Insert Visualization dialog, hit the Import File… button.  Browse to the 
examples/data/head.dat file in the IDL distribution and hit OK.  This will bring up the binary file 
reader dialog.  The binary file you have selected contains a three-dimensional array of byte 
values that represent an MRI cube of a human head.  The dimensions of the array are 
[80,100,57].  In the binary file reader dialog, hit the New Field… button.  In the subsequent dialog, 
give the field a name (e.g., “volume”) and set the number of dimensions to 3.  Then, set the first 
dimension to a value of 80, the second dimension to a value of 100, and the third dimension to a 
value of 57. 
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Hit OK twice.  You should now see the “head.dat” data at the bottom of the list in the data 
manager. 
 

 
 
Next, you need to assign the data to a parameter to create a visualization. In the lower left of the 
Insert Visualization dialog, choose “Volume” from the Parameters droplist. Then, select “head.dat” 
in the tree and hit the little arrow below to assign this data to the “VOLUME0” parameter field.  
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Finally, hit the OK button.  You will now have a volume visualization, although by default the 
volume is represented by a gray box.  This is because volume rendering can be very time and 
memory intensive.  To render the volume, you can hit the Render button in the new Volume tab 
that has incidentally appeared in the side panel of the tool.  The Render button will give you a 
one-time rendering.  You can also check the Auto-render checkbox in the panel for continuous 
rendering, if your machine is fast. Before adding color to the volume set the Canvas Zoom to 
200% and then scroll down and right to view the volume. 
 
By default, the volume is displayed with a linear grayscale ramp color table.  To change the color 
table, go into the volume property sheet and edit the “Color and Opacity Table 0” property.  
Choose one of the pre-defined color tables, and then re-render the volume to see the new colors.   
 

 
 
Next, extract an isosurface for the volume.  With the volume selected, choose Volume/Isosurface 
from the Operations menu.  In the resulting dialog, choose a value near 200.  Depending on the 
isosurface value, the resulting isosurface may have very many vertices.  A value of about 200 
should produce a fairly manageable isosurface for most machines. 
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Finally, apply the Image Plane operation to the volume.  To do this, choose Volume/Image Plane 
in the Operations menu.  This will extract an X image plane (parallel to the YZ plane) in the center 
of the volume.  Drag the plane along the X axis by grabbing onto its edge.  The extracted image 
will update as you drag.  By default, the plane uses the volume’s color and opacity tables.  In the 
property sheet for the image plane, you can change the “Opacity control” property to a value of 
“Opaque” so that the plane shows up better.  You can also change the Orientation property to 
convert the plane from an X plane to a Y plane or a Z plane.   
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23.) Print Preview 
 
Set the Canvas Zoom droplist in the toolbar back to 100% to see the whole iTool canvas again.  
Choose Print Preview from the File menu.  This will bring up the Print Preview window.  Here, you 
can: 
 
• Switch from a Portrait page setting to Landscape using the droplist at the top.   
• Hit the Center button to center the canvas within the piece of paper.   
• Interactively set the margins by dragging on the margin handles (black rectangles with dotted 

lines.   
• Grab and drag the black rectangle handle in the top right corner to resize the canvas on the 

piece of paper.   

 
 
Hit the Print button if you wish to print or hit the Close button to close the dialog. 
 

24.) Saving Your Work 
 
You can save your work when you use the iTools and come back to it later.  When you close the 
iTool window, you will be asked if you want to save.  Hit Yes, and you will be prompted for a 
filename.  The file will be given a “.isv” extension.  Later, in a completely new IDL session, open 
this file, either from within an iTool window, or from the File/Open option in the IDL Development 
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Environment. Your iTool will be restored exactly as you left it, including the data, so that you can 
continue working. 
 

End 
 
 


